
Any application can be added to the Dock simply by dragging its icon to it. You can also remove an item

from the Dock just by dragging it up and off the Dock. Any running application appears in the Dock,

whether or not you decide to permanently add it there. Each application has different Dock menu options -

actions you can take right from the Dock, whether or not that application is the active application.

The Taskbar (Windows)

In Windows, the default location for the taskbar is at the bottom of the screen, though you can move it to

the edge of any screen. By default it contains the Start menu button, Quick Launch bar, taskbar buttons and

notification area (shown right). 

You can use the Quick Launch area to place shortcuts to commonly used applications. Taskbar buttons are

created for each document window you have open, so it's a good way to quickly switch between multiple

open windows. The active window appears lighter than other open windows or applications in the taskbar.

ASCII - or how your computer learned English

We talked a little bit about ASCII (pronounced "ask-key") when discussing binary numbers. ASCII is a

character set that consists of 128 numbers (0-127) assigned to letters, numbers, punctuation marks, and

other commonly used characters.

Check out this chart below learn how it works. 

In the right-most (white) column:

letter a=Decimal (light yellow column) 97, b=98, etc...(notice these are lower case letters).

In the third column:

letter A=decimal number 65, B=66, etc (these are upper case letters)



ASCII is an acronym for the American Standard Code for Information Interchange. In ASCII, each 8 bits

are grouped together in a byte, and each byte corresponds to a single character. This allows for 2^8=256

possible characters. Since there are only 26 letters in the English alphabet, plus 26 uppercase letters, plus

10 digits, plus a dozen or so punctuation marks, there are quite a few extra characters leftover. That is, if

you're using English!

(A tiny movie example of ASCII in action courtesy of Dick Barton.)

Unicode - going to global character sets

If you are using a language that requires more than 256 characters, ASCII just won't do. So, for companies

who are writing applications that available in many different languages, they have adopted the Unicode

standard rather than ASCII. Unicode uses 16 bits to describe characters, rather than 8 bits used in ASCII.

So it can support 2 to the 16 or 65536 different characters.

These formats are whats behind the scenes when you save a text document in different formats.

Using a simple text editor

If you can understand how to open your applications, create documents, and know where to save the

documents you create, then you have a great start on being a digital media professional. You'd be surprised

how valuable these very basic skills can be throughout your career.



As you've seen, an application is a program that you can use to create documents, movies, photo collages,

etc. You use different applications for different tasks, but one of the most basic, often used applications is a

word processor. You can type a letter, write a script, or even complete your next novel in a word processor.

If you're using a Mac you'll find you have an application called TextEdit. If you use a PC, you'll find

Notepad and Wordpad applications. These are the simplest word processing applications out there. What's

so nice about these is that they load quickly, are already installed on your computer, and are very easy to

use.

TextEdit on the Mac
You can find TextEdit on your Mac in the Applications folder. TextEdit includes tools to format and layout

your page, edit and stylize text, check spelling, create tables and lists, import graphics, work with HTML,

and even add music and movie files. We'll talk about file format options for saving your TextEdit files on

the next page.

You can either start a new document (File > New), or edit an existing document (File > Open). 

Notepad and Wordpad on Windows

On your Windows XP computer, you can find Notepad and Wordpad in Programs > Accessories.

Both Notepad and Wordpad are text editors that are included with the Windows operating system. Notepad

is the most basic text editor you can use. While you can create several paragraphs of text with Notepad,

using line breaks (by pressing the Enter key), the program does not give you text formatting options. For

example, you cannot change the font size or make the text bold.



WordPad is similar to Notepad, but gives you more formatting options. You can use bold and italics

formatting, and change the font, size, and color of the text. You can also create bulleted lists and center

paragraphs. 

More Advanced Editors

If you want even more formatting options and a more user-friendly interface, you can use a program such

as Microsoft Word. Available for both Mac and Windows, Microsoft Word is possibly the most popular

word processing program of all time. It's not a free application, but lots of people use it. It can do anything

you could possibly ever want to do with text, but most of us probably only use about 10% of the features!

You use the I-beam cursor (shown below at the top of the blank document) is the insertion point letting you

know that this is where you're going to start editing (it typically flashes). It will work like this in your word

processor, but also in your advanced audio and video editing applications.

Cut, Copy, Paste

If you've used your word processor at all, you probably already know that you can cut, copy, and paste

words, sentences, even entire paragraphs from one place to another. You can do this within your document,

or between multiple documents. Great - big deal you think. Would you believe me if I told you that

knowing how to manipulate text in a text document is the exact same skill you need to edit audio or video?

Or that you can make web pages just by using a text editor? Or deliver your audio as a podcast with

Wordpad or TextEdit?

• Cut (Command-x)

• Copy (Command-c)

• Paste (Command-v)

These are universal - used in every application, and always found in the Edit menu. You first select the

words (or sentence, or entire paragraph) you want to remove, for example, and then go to the Edit menu



and choose Cut (or Command-c) and then they are stored on your clipboard.

How does it work?

When you use the Cut or Copy functions, the information is stored in the computer’s temporary memory in

an area called the clipboard. Although you cannot see the information, it remains in the computer clipboard

until you use the Copy or Cut command again, at which time the information that was in the clipboard is

then overwritten with the new information. (Some applications, like Microsoft Word for example, let you

keep more than one item on the clipboard at a time.) When you Paste, you insert the clipboard contents into

your document wherever your insertion point is in your document.

You can use the clipboard to copy information within a document, between documents, and sometimes

even between applications.

Text File Formats

Every type of application, whether it's a word processor or a video editor, will have a lot of different file

formats you can save your document in. As time goes on, new standards are created that keep the wheels of

progress moving forward in the computer industry. Let's look at what all those different text file formats

really mean. And why would you choose one format over another?

The coolest part about file formats (they are also called extensions) is that they are standards. In a rapidly

evolving computer field, standards are awesome because people write software that follows these

standards. This means that if I write a paper in Microsoft Word and save it as a .txt file, you don't

necessarily need Microsoft Word to open that file! If I really saved my Word file as .txt, you could open it

with TextEdit, or with Notepad/Wordpad. You could read the document, make any changes to it that you

want, and even save a new copy of it.

Check out all these way I can save a text file I created in Microsoft Word on my Mac.

For text document, here are four really important formats you should know about.

Text Only (.txt) Saves your text document as an ASCII text file. Saving as a .txt file removes any

formatting you have in your document - anything you made bold, or indented, or changed to a fancy font

will not be preserved. Your document will be converted to the most generic text you can get! This is good

if you don't know how your file will be viewed. Or, this is the format that you use for web pages and even

for blogs and podcasts - you save HTML and XML and most code files as text-only. 

Document Format (.doc/.docx) Saves your text with all its formatting in a format that can be read by

Microsoft Word, WordPerfect, or OpenOffice (a free, open-source alternative to Microsoft Office). This is



a pretty good way to save a text file if you're sure the person who will be accessing it has a fairly good

word processing program. Or, if you are typing a document and you know you're the only one using it, then

by all means, save your formatting! In the graphic above, you'd choose Word Document to get this .doc

format. With recently releases (Office 2007, Office 2008 for Mac) of MS Word you'll start to see the .docx

extension. This format can only be opened by the newest word processors.

Rich Text Format (.rtf) Saves your text with some (most) of the formatting. This is sort of like an

enhanced .txt file. It tries to save formatting information like font and margins, but it may not store every

bit of your formatting. Because it's a standard, many word processing applications can read a .rtf file, and

any formatting that the application can not understand, it will simply ignore. This is a good choice if you

want to share your document in editable format, but aren't sure if the other person has Microsoft Word.

Portable Document Format (.pdf) Saves your word processing document, along with any graphics you've

inserted, exactly as they appear. When you save a file as a PDF, you can be assured that almost any

computer user with any application will be able to open and view your document. And, it will look exactly

as you designed it. This makes it ideally suited for saving documents with complex formatting. You can use

a free Adobe Acrobat program, or the Preview application in Mac OS X, to view these documents. For

better or worse, you can not edit a PDF file, so if you do share a document as a PDF, you'll be sure no one

is changing it along the way. Think of it as a snapshot of your text document.

Saving Files

Below you'll find directions for saving text documents in Rich Text format from Word, TextEdit and

Wordpad. You can decide which format is right for you, the saving process will be about the same as

described below.

To save a document in Rich Text format using:

• MS Word
In Word choose Save As from the File menu, then make sure to choose Rich Text Format from the

Format menu in the Save window. When you have this Save window open, check to see if you

have the "Append file extension" box checked. If you do, you should see the file name

automatically change from .doc to .rtf when you properly select Rich Text Format from the

Format pop-up. This lets you know that you have successfully saved your document as an .rtf.

Simply changing the file name to include .rtf but leaving the Format pop-up set to Word

Document does NOT create a .rtf.

• Using TextEdit
If you are using TextEdit on the Mac, make sure to choose Save As and then check or change the

File Format pop-up to display Rich Text Format. If you don't see this option, check the TextEdit

Preferences and make sure your New Documents are created using Rich Text rather than Plain

Text.



• Using Wordpad
If you are using a PC with Windows....Wordpad defaults to saving files as .rtf. Notepad saves as

.txt by default. So if you're using a PC, the easiest solution to easily making .rtf files is to use

Wordpad.

Organizing Your Files

I make a lot of little movies. Each movie has anywhere between 10 and 20 images, an audio file, and then

there are multiple movies. All this mounts up to hundreds and hundreds of files every month. Sometimes I

need to get back to these files! Really. If you never had to re-do old work, or update a resume, or update

your website, then it wouldn't really matter where you save your files. But, you always have to make

updates. And, if you're working at a production company, you'll certainly need to be sharing files with

others.



Keeping your computer organized is as important as keeping your important documents organized, or

keeping your portfolio up-to-date. And, if you're confident about your organization scheme, you'll find

yourself much more adventurous when it comes to trying new things on your computer. It's like having a

good safety net. When you're not worried about loosing your data, you can think more about your projects,

and less about how you're going to find them again.

Some applications, like one that I use on a daily basis, require that I place all my media files into a single

folder, and I have to call the folder "Library". As long as the application can find this Library folder, saved

at the same level as the project file, it functions great. In some ways I really love an application like this,

because it absolutely forces me to be methodical and organized when I'm making my movies.

Other programs let you save files wherever you want. This lets you be disorganized when you're in the

middle of your creative thinking, but you run the risk that you'll never find your source material again. Or

worse, you'll accidentally delete your source material and your work will be lost forever.

Sometimes you'll find that your operating system, whether Mac OS or Windows, will help you store files in

logical places. On a Mac, you'll find folders for Movies, Music, Documents, Pictures, etc. This organization

scheme works well for a lot people. I recommend using the features in whatever operating system you use

to help you stay organized.

In Windows, it's not called "Home", but rather "My Documents", "My Pictures", and "My Music". You can

get there right from the "Start" menu.

So you can see, if you have to jump from one system to another, that each may have its own naming



scheme, but they are pretty similar. I'm not saying you won't "prefer" to work in your "native" environment,

but it's nice to be able to use any computer available.

Backing Up Your Files

Having a backup of your files is a very good idea. But, to truly take advantage of the safety that backing up

affords, you should back up your files to someplace other than the hard drive in your computer. Because, if

both your original and your backup are on the same drive, and then something happens to your computer,

now the original and the backup are both lost! Backup to some other media - a CD, a DVD, an external

hard drive, or a server for example. 

Creating folders to group similar documents in one place is a great way to get organized. The idea is that

you name your folder something meaningful, and place all documents that relate to that folder inside. For

example, I have a folder for all the files for my online course. Inside that folder, there are individual web

pages for each page you'd see in your browser.

You might also notice that I don't have any odd-ball characters in my file names, no blank spaces, and I

keep everything lower case. This is my "standard" which helps me stay organized. You'll find a system that

works for you.

Files on the Desktop

For those of us who are not as organized as we should be, the Desktop of the computer seems like a decent

place to store files. (I once ran into someone who used his Recycle Bin to store his files! Yikes!) Files



stored on the desktop are really easy to find. But, files really DO NOT belong on the Desktop. Why? Well,

because if you ever have to work on a public computer, say in the library, or in a production facility, files

stored on the Desktop are usually immediately trashed by system administrators. Think of your computer

desktop like a real-world desk - you can place document on top of the desktop while you're using them, but

when you get up, you probably want to file them away in a folder, and then place the folder in a drawer.

That being said, don't store your files in some obscure place on a public system hoping no one will notice

(of course, you'd like to find them again). Those industrious lab/networking folks always seem to find

them. In fact, it is very easy for those system administrators to find these stray files and delete them. If you

get in the habit of carrying around some portable storage device (more on this later), then you'll always be

assured decent, secure storage space.

But...I know, it's easy to save a file to the Desktop. And yes, if I took a screen shot of my computer right

now, there are files on my Desktop. Now, those files are documents that I've temporarily saved to the

Desktop (because it was convenient) and then, at the end of the day I (typically) move those files to

appropriate folders.

There are two important things (in my mind) to mastering file management:

• Always save your documents in their proper location and/or 

• Always clean up after yourself and move files to their proper location before you leave for the

day. 

Saving Documents

A good way to start getting organized is to pay close attention to where you save your files. This way,

you'll immediately place them where you want them, rather than having to move all your documents

around. Think of it like preventative maintenance. When you see a Save dialog box, pay attention to what

you have selected in the Where section (see image below).



Save 

My advice on Save is this - as soon as you get a document open (let's say a word file), save it as soon as

you type the first words in the document. If you save when you first start out, you'll have a sense of the

document's topic (so you can come up with a decent file name), and you'll choose where to save the

document right away.

When you Save a new "Untitled" document for the first time, you'll get a dialog which looks similar to this.

After you save your file the first time, you can use Apple-S (on a Mac) or Command-S (on a PC) to quickly

save your file. When I'm writing a Word document, I turn on the auto-save feature if the application

supports it (Microsoft Word does, as do many other applications including audio and video editors). In

addition to the auto-save feature, I typically save every time I have to stop typing to think for a second. You

can never save too often - especially when you're doing creative work with your computer. 

If I'm using an audio or video application, I have forced myself into the habit of saving before I preview my

video, or listen to an audio edit. Yes, every time. This means I save regularly, just in case anything happens

to the computer. Final Cut Pro and Premiere for video editing also have an auto-save feature. It takes much

less time to save than it does to re-create original thoughts, or amazing video edits. Save, and save often?

For graphics applications, I find it much harder to remember to save - since I'm always seeing the results of

my work as soon as I make a change. In this case, I try to save whenever I'm thinking about what I need to

do to the image next. You'll come up with your own "prod" that will get you to periodically save your

documents. 

Save As

The Save As command let's you save copies of your document. This is useful in situations where you need

to keep (or want to keep) old versions of your work. Maybe you're using an audio editing program and

you're fairly happy with your edit, but you want to try something different - without screwing up the work

you've already done. You can "Save" your file "As" a different name, and then perform the different edits

on the new file.



Many applications let you do a Save As and convert the file type (change its extension, convert a word

document to a text file, etc). This is a great way to save one file in multiple formats. For example, you'll do

this a lot if you make graphics for the web. You'll make a beautiful, large file for your original, but save a

compressed version to display on the web. This way, if you want to make changes to the graphic at a later

date, you'll still have the large, beautiful file to go back and work with.

A word of caution. With Save As you can easily end up with multiple versions of the same file. It can be

difficult to recognize the differences between two versions of a long word document when you go back in 6

months to look at the document. You can look at the "last modified" date on the files to figure out which is

the latest version, but this may or may not help solve the mystery of which file you really want!



The moral of the story: Save as often as you can remember to save. The shortcut for most applications is

Apple-S (on a Mac) or Command-S (in Windows).

Finding Files on Your Computers

If you're really diligent and have a great filing system on your computer, you'll never have a problem

finding any document you create. And, ideally speaking, all your applications will be stored in the same

place, so you'll never lose those either. And, any files you download from the Internet you'll either save

right to the proper folder, or download to your desktop and then file them away shortly. This would be an

ideal world. This would be how Martha Stewart's computer would always be organized.

It's a goal to strive for. The closer you get to the perfect organization scheme, the easier your digital life

will be. You'll confidently browse through the folders on your computer, secure in the knowledge that you

know where all your stuff is.

But, often there are distractions that come along, and the next thing you know you're in a hurry, you have to

run to get the phone or whatever, so you just save your file to some folder on your computer. Then, when

you get back to your computer, you can't remember where you put the file!

With Windows or Mac OS you can use the Find/Search feature to locate files in a few different ways.

Search by File Name

I know my own naming convention, so, if I were to update my web page right now, I know that I can find a

paper I wrote because, to this day, I remember the name I gave it. Really. I almost never name documents

the same thing. I needed to find a movie that I used as a test to see how to close-caption. My filename:

ccornot.mov....because it was a test to see if you could turn off closed captioning (get it? cc or not). The

good news is that my file naming scheme doesn't have to make any sense to other people, it only needs to

make sense to the person who's using it. Your file naming scheme needs to make sense to you. Figure out a

convention that works for you, and then stick with it.

You can search from any Finder window (Mac) and search for files by filename, or even the contents of the

file.



In Windows, you can use the Search feature (and let Spot the dog help you) to search by file name. You can

also include information about when you think the file was created.

If you're making files for the web, its a good idea to stick with convention and make all your documents

have names that are in only lowercase, have no odd characters or spaces, and contain the proper file

extension. We'll get more into file extensions later on, but for now, decide what makes sense to you, and

then stick with it.

Search by Date

Sometimes I think I was smart - and I think I remember what I called a document, but when I search by

name (or even a partial name), my search comes up with nothing. It's not time to panic yet. If I can't

remember the name, I can usually remember about when I made the file (or used the file last). You can

search by Date Modified to find documents that you made today, yesterday, in the past week, or in some

other time frame. This can often be just the trick you need to find the file you're looking for. When you find

it, you might consider renaming it to something you'll remember next time!



There are a lot of other ways to search for documents on your computer, but searching by Filename and by

Date Modified are two of the most useful. What other ways do you use to find those documents that have

gone missing from your computer?

Spotlight (for the Mac)

If you have Mac OS X v. 10.4 or higher you can use Spotlight to help you find files. It's pretty neat because

you can enter keywords into the Spotlight window (upper-right of the Finder) and the OS will not only

search for file names that contain that keyword, but it will actually search the contents of your documents.



So if you search for "digital media skills" you'll find documents with those words, or any documents you've

created that contain those words. So if I have papers that I've written that have those words, but the

filename is called something completely different, Spotlight will find it. It searches PDF, movies

(keywords), pictures, email messages, whatever. This can really get you out of a bind when trying to find

your files.

Search using Windows

Use the Search options (in the Start menu) for finding files, folders, or applications on your Windows

computer. You can limit your searches to just pictures, just documents or a lot of other formats.

Taking a Screen Shot

So often tech support, or a co-worker at a remote site, or someone wants to have to screen shot of

something on your computer. These can be really useful to you because you can then "take a picture" of

anything on your computer and use it anywhere you want - print it, email it, include it in your next video,

or post it to you blog.

And the easy (and free) solutions that follow produce so much better results than taking out your digital

camera and clicking a picture!

On a Mac 

Command-Shift-3 will take a picture of the entire desktop. You'll find a file "Picture1.png" on your

desktop.

If you want to take a snapshot of just part of your screen, use Command-Shift-4. You'll see your cursor turn

into cross-hairs and you can then drag to create a selection that you want to capture. 

I tend to take a lot of screen shots, so I use an application called Snapz Pro

(http://www.ambrosiasw.com/utilities/snapzprox/) which allows me to both take screen shots easily, in any

format I want, but I can also use it to capture screen movies!

On a PC 

In Windows 7, your best option is the Snipping Tool - which is an easy to use, but pretty sophisticated

screen capture tool, built right into your operating system. In Windows XP,  you'll use the "PrtScn/SysRq"

key on the extended keyboard. When you press this key you may not notice that anything has happened.

This copies what's on your screen to the clipboard - so you'll need to open up another application (maybe

MS Word or WordPad) and then go to the File menu and choose Paste. You'll see your screenshot appear in

the file.

Another way to get an even better quality screen shot is to use an application like SnagIt. Go to

http://www.techsmith.com/screen-capture.asp and then click Download Free Trial.

Finding Out What's Inside Your Computer

We've all had the experience of needing technical support - and sometimes this can be painful! One of the

ways to get better answers it to ask better questions. If you can at least begin to speak the same language as

the tech support folks, then you're more likely to get satisfying answers. What follows is information that

you can use to find out exactly what type of computer, and operating system you have on your home

computer.



Find your system specs including:

• Type of Computer Hardware, Processor, and Speed 

• Operating System and version 

• Hard Drive Space (total and available) 

• Amount of RAM installed 

• Graphics Card 

• Sound Card 

• Types of External Device connections (USB, FireWire, etc) 

If you're using Windows XP

Go to the Start Menu -> Programs -> Accessories -> System Tools, and then select System Info. You'll

open an application that will tell you all sorts of information about your computer. In the Left pane, expand

the 'Components' section, and then click 'Display' or 'Sound Device' to find out about your video and audio

devices, respectively.

You can find out about the amount of RAM on your computer under the "System Summary" section. It

may be called "Total Physical Memory"

To find your hard drive capacity, go to the Storage -> Drives section. You'll see a list of each drive you

have (if you more than one drive or multiple partitions) and you can see the "size" and "free space for each

one". Then you can add them up.

Alternatively, to get the hard drive space, you can open Windows explorer (NOT Internet Explorer) and

click My Computer. You'll see a listing of all the drives and their total/available space.

If you're using Mac OS X

On a Mac, you can find detailed information about your computer hardware by going to the Apple menu,

and then choosing About this Mac.

In the window that appears, you'll find your system software version information, processor speed and

memory (RAM) information. If you click "More Info" you'll bring up the Apple System Profiler that tells

you everything about your computer. Expand the Hardware item in the Contents field, and you can select



all the different hardware devices. You'll see all the information about your computer.

Basics of a Computer Monitor

Your computer's monitor is literally your window to the digital world. Today, there are two basic categories

of monitor. A CRT (cathode ray tube), or an LCD (liquid crystal display). LCD (and now LED) monitors

(also known as "flat panel") are the monitor of choice for digital media artists. They are slimmer, so they

take up less space on your desk, and they require much less power to operate, so they keep your energy

consumption (for a desktop computer) or battery consumptions (for a laptop computer) way down. Mostly

you'll find LCD and LED to be what's available now.

Computer Lab with CRT monitors



Computer Lab with LCD monitors

LCD monitors have a lot of advantages, which we'll get into in a minute, but they are also typically more

expensive than CRT monitors. You might also see these marketed as AMLCD - active-matrix liquid crystal

display.

What is a Multisync monitor?

Multisync allows a monitor to understand any frequency sent to it within a certain bandwidth. The benefit

of a multi-scanning monitor is that you can change resolutions and refresh rates without having to purchase

and install a new graphics card or monitor each time. Because of the obvious advantage of this approach,

every monitor you buy today is a multi-scanning monitor.

Display Connector Types
A lot of computers use a VGA connector (analog) to pass video signals from your computer to your

monitor. These are typically used when connecting to a CRT monitor. VGA carries three separate lines for

the red, green and blue color signals, and two lines for horizontal and vertical sync signals. In a normal

television, all of these signals are combined into a composite video signal. On your computer monitor,

however, they remain separate. This separation of the signals is one reason why a computer monitor can

have so much higher resolution than a TV set (it looks a lot sharper). The important point here is that your

computer monitor has a lot of similarities to your television monitor.

Since VGA adapters display analog video information, a new standard was designed to make use of digital

LCD monitors. DVI (digital video interface) keeps the signal coming from your computer as digital

information, so the color and quality of your monitor are pristine. It is an uncompressed video signal.

Because VGA technology requires that the signal be converted from digital to analog for transmission to

the monitor, a certain amount of degradation occurs. DVI keeps data in digital form from the computer to

the monitor, virtually eliminating signal loss. DVI is technology-independent. Essentially, this means that

DVI is going to perform properly with any display and graphics card that is DVI compliant. Because this is

a digital connection, you can use a converter to convert to an HDMI connection

HDMI is an acronym that stands for High Definition Multimedia Interface. It is an extension of the DVI

digital standard mentioned above. It can carry digital high-definition video and multi-channel audio

connectivity. HDMI can also carry remote control signals.The video portion of HDMI and DVI signals are

identical. That is why a cable can be made that connects to HDMI on one end and DVI on the other. HDMI

is a standard connector for high definition television sets. So, if your computer has a DVI or HDMI output,

then you can connect it to your fancy, big LCD and plasma television. This is great if you're doing group-

based computer projects so everyone can see the monitor, but, if you computer happens to have a Blu-ray

DVD player in it - you can use it to play high-definition video and watch it on your nice television!

Another fairly common choice is to hook your computer up to a projector. Many of us have had to do this

to demo something in front of a classroom using our own laptops, but some people like using projectors

just so they can rest their eyes a bit, and watch video on a really large screen. Most projectors (but not all)

are still using a VGA type connector - so you'll need to make sure your laptop has the right cable to connect

to these projectors. Windows laptops have lots of different external monitor connector types - some are



VGA, some are HDMI. Most Mac laptops use DVI connectors, and you need to carry a DVI to VGA

connector with you to make the connection to the projector. 

Size of Your Monitor and Viewable Area

Three measurements are used to describe the size of your display: the aspect ratio and the dimensional

screen size and the viewable area. Many computer displays, like many (older) televisions, have an aspect

ratio of 4:3. This means that the ratio of the width of the screen to the height is 4 to 3. The other aspect ratio

in common use is 16:9. Used in cinematic film, 16:9 was not adopted when the television was developed

due to the difficulty of creating a CRT that could accommodate the format. Technologies have greatly

improved, so the aspect ratio has never been a problem with the manufacture of LCD and plasma

televisions. In fact, as widescreen TVs become more popular, most television and computer monitor

manufacturers now offer 16:9 displays.



The display area includes a projection surface, commonly referred to as the screen. Screen sizes are

normally measured in inches from one corner to the other corner diagonally across from it. This diagonal

measuring system actually came about because the early television manufacturers wanted to make the

screen size of their TVs sound more impressive. Be sure you ask what the viewable screen size is. This will

usually be somewhat less than the stated screen size. Larger is generally more expensive, and heavier.

Popular desktop computer monitor sizes are 15, 17, 19 and 21, 23, even 30 inches! Notebook screen sizes

are usually somewhat smaller, typically ranging from 12 to 19 inches (netbooks are even smaller in the 9"

range). Obviously, the size of the display will directly impact resolution. The same resolution will be

sharper on a smaller monitor, and fuzzier on a larger monitor, because the same image is being spread out

over a larger number of inches. An image on a 21-inch monitor with a 640x480 resolution will not appear

nearly as sharp as it would on a 15-inch display at 640x480. Let's look at little more about this.

Resolution

Resolution refers to the number of individual dots of color, known as pixels, contained on a display.

Resolution is typically expressed by identifying the number of pixels on the horizontal axis (rows) and the

number on the vertical axis (columns), such as 640x480. The monitor's viewable area (discussed in the

previous section), refresh rate (see below) and dot pitch (size of the pixels) all directly effect the maximum

resolution a monitor can display. Some monitor manufacturers may allow for such high resolutions at a

high cost but the user will never utilize such a resolution - icons on the screen just get too small to see! 

Resolution is also sometimes referred to in ppi (pixels per inch), which is just another way of expressing

the value. 

Aspect Ratios



Refresh Rate

In monitors based on CRT technology (or analog projectors), the refresh rate is the number of times that the

image on the display is drawn each second. If your CRT monitor has a refresh rate of 72 Hertz (Hz), then it

cycles through all the pixels from top to bottom 72 times a second. Refresh rates are important because they

control flicker, and you want the refresh rate as high as possible. Too few cycles per second and you'll

notice flickering, which can lead to headaches and eye-strain. Some people are more sensitive to this

flickering - if florescent lights drive you crazy because of flickering light, you'll want to make sure you

have your refresh rate set as high as your monitor will support.

Televisions have a lower refresh rate than most computer monitors. To help adjust for the lower rate, they

use a method called interlacing. This means it draws all the odd rows from top to bottom, then starts over

from the top drawing the even rows. The phosphors hold the light long enough that your eyes are tricked

into thinking that all the lines are being drawn together. 

Because your monitor's refresh rate depends on the number of rows it has to scan, there are limits the

maximum possible resolution. A lot of monitors support multiple refresh rates, usually dependent on the

resolution you have chosen. Keep in mind that there is a trade-off between flicker and resolution, and then

pick what looks best for your eyes.

Refresh rate isn't an issue with LCD or LED screen, because they have a backlight that is always on. You

might see response time ratings or latency - this refers to how well a monitor can display moving images.

As with most things computer - faster is better.

If you've ever seen pictures or video taken where there are a lot of computers with CRT monitors - you've

seen the "scan lines" that are a by-product of the refresh rate.

Inkjet Printers

Color inkjet printers are really popular, and pretty darn cheap! They are good for printing out both text and

do a decent job with your own digital photos. Even though the printer may only cost $49, pay attention to

how much ink cartridges cost. This can really bring up the total cost of ownership.



Some printers have ink cartridges that combine color (red, green blue), and black into the same plastic

assembly. Some of the printer cartridges also include the print head that actually dispenses the ink on the

paper.

There are about ten-zillion different kinds of ink cartridges. Be sure to check the number on yours before

you buy a replacement or get it refilled.

If you don't use an inkjet printer very often, the ink can dry up - making it even less cost effective per print.

So consider how much printing you'll really do before purchasing one.

Photo printers

These typically have higher quality output than inkjet printers and work great for printing your own digital

pictures. Many offer quality so good you can't distinguish their output from photos printed professionally

using a more conventional process. The higher priced models probably print nearly the same quality as the

lower priced models - the difference is primarily in speed and features. Often many of these print only to

one paper size, often 4 by 6 inches.

Laser Printers

I never used to include this topic - because laser printers were just too expensive "for the rest of us", but

they've gotten a lot cheaper - some as low as $100. You have a lot of options - from black and white only,

color, to all-in-one machines that print, copy, scan, maybe even fax. If you have lots of pages - and lots of

text to print out, nothing is better than a nice, crisp, laser print. And they can often print many more pages

per minute than inkjet printers.

Laser printer require toner cartridges - so check the price of these before you decide which model is right

for you. Many public access computing facilities have laser printers available for use - they are durable and

fairly inexpensive to run.

Printer Paper

There are plenty of different kinds of paper you can get to suit all your printing needs. You can use regular

paper, like what you find in a photocopier, for your daily printing needs. They also make beautiful glossy

paper that will make your digital images really shine. You can get T-shirt iron-on transfer paper, and even

fabric like paper that will make your print resemble a painting. 

When you Click OK to Print

Check out the following web page for a great description of the whole printing process - from when you

click print, to what's happening inside your printer. (really, its worth checking out)

http://www.howstuffworks.com/inkjet-printer4.htm

Printer Drivers

With some operating systems, you'll need to find drivers so your printer will work with your computer. In

Mac OS X or Windows 7, for example, you'll find that you can hook nearly any modern printer up, and the

operating system will just recognize it. In cases where your printer needs a driver, you'll get software with



your printer, or you can download it for free from the printer manufacturers website.

Connecting a Printer to Your Computer

Most newer printers are USB printers. USB (Universal Serial Bus) is a common connector for printers,

digital cameras, scanners and other computer peripherals. In fact, your computer probably has its mouse

connected with a USB connector. USB ports are incredibly simple to use.

Other older computers and peripherals use parallel ports, or SCSI (pronounced skuzzy) (small computer

system interface) connectors. These both had their drawbacks, and have pretty much been rendered

obsolete with the invention of USB and FireWire. 

Printing wirelessly

If you have a wireless network then you might even be able to print wirelessly, just by using your wireless

router. If one of the computers on the network has a printer attached, all of the computers on the network

should be able to access it -- as long as your printer is designated as a "shared" printer for the network. If

your wireless router doesn't have a built-in print server, you can get a stand-alone print server.

Understanding the Connections to Your Computer

USB 1.1 "Full Speed" USB

USB (Universal Serial Bus) is a standard connector type that both Macs and PCs use. You'll find that most

digital still cameras, flash drives, portable MP3 players, headset microphones, computer mice, game

controllers, scanners, printers, and other peripherals all use USB to connect to your computer. The idea

with USB was that it was cheap for manufacturers, and that it had decent speed, and allowed lots of devices

to be used at once. 

In the early days, computers had a whole bunch of different kinds of ports, and Macs and PC often had

different ports - making it nearly impossible to share devices between the two. It was confusing if you were

trying to use both platforms, and even if you just used one platform, things were less interchangeable than

they are now with USB. There used to be parallel ports, serial ports, special mouse and keyboard ports,

SCSI ports. It was a mess.

USB 1 is limited to 12 megabits per second transfer speed. Suffice it to say, 12 megabits per second is

completely adequate for most of the devices that use USB right now. It's considered "plug and play" in that

you don't need to restart your computer in order to have a new device accessible on your system. You can

plug in the USB device, and it is immediately recognized by your operating system. You can also safely

unplug most any USB device at any time (see below for more information on "flash drives"). Best of all,

there's no need to assign unique device IDs (SCSI numbers) to each device like you used to, and no need to

worry about what order you plug devices into your system.



USB can have up to 127 devices per bus! I have never seen anyone come anywhere close to needing this

many external USB devices connected to their computer. Consider using a USB Hub is you have more

devices than available ports.

And Now There's More Than One USB Spec

So, since the invention of USB in 1996, there have been some improvements - mostly because consumers

have demanded faster and faster transfer speeds, but still with the flexibility of "plug and play". The above

section talked about USB 1.1 or "Full Speed USB", which has a bandwidth of about 12 megabits per

second. This is very common, and can be found on most personal computers.

An enhancement to 1.1 specifications is sometimes known as "High Speed USB" or USB 2.0, which can

give you bandwidth of up to 480 Mbps - or almost 40x more than the original USB 1.1. Pretty fast. It's

available on "newer" computers, and you'll find hard drives and some digital still and video cameras use

this specification. Just remember, not all devices have the same "need for speed". So a nice digital camera

may benefit by transferring images faster, but your keyboard or mouse is unlikely to benefit from these new

enhancements.

We are seeing a lot more video cameras that use USB 2.0 rather than FireWire 400 connectors. There really

are nominal speed differences between the two, but its important to know what ports you have on your

computer that you intend to attach the device to! If you don't have a FireWire port on your computer, don't

buy a FireWire video camera.

USB 2.0 is backward compatible with previous revisions of USB. You can use a USB 1.1 device or

peripheral in a USB 2.0 port, but your device will not run any faster than it was designed to. 

A Note about USB Flash drives and USB iPod/MP3 players

So everyone seems to have one now - these USB Flash drives (sometimes called jump drives) are great for

carrying around your files. We'll discuss them more when we talk about storage later, but here's an

important note to my discussion about USB. You should not simply unplug flash drives from your

computer. Even though they are USB devices, you should "unmount" them to safely remove them from

your computer. This helps ensure that you won't lose any of the data stored on them. 

These flash drives and your portable media devices - like iPods, MP3 players, probably your cell phone,

etc. are important exception to "grab-and-go" rule with USB. If the USB device manufacturer has asked

you to "dismount" it, then please do so! You can safely dismount a device from a Mac by dragging its icon

to the trash. On Windows, just click the "safely dismount devices" icon in the task bar area in the lower-

right of your screen.



FireWire 400 (IEEE 1394, iLink)

This connection was original invented by Apple in 1995 (for which they received an Emmy), it was later

standardized as IEEE 1394. FireWire, iLink, and IEEE 1394 all refer to the same connector. Devices that

have much higher data transfer needs, like video cameras, external hard drives, and a lot of audio

equipment all use FireWire because it is much faster than USB 1.1. It can transfer 400 Mbps.

FireWire can support up to 63 devices on a single bus. Again, there is a limit, but I've never seen anyone

encounter this in real life. Like USB, FireWire is also plug and play.

Most digital video cameras have an IEEE-1394 plug. When you attach a camcorder to a computer using

IEEE-1394, the connection allows for many different kinds of data transfer. For example, with the right

software the computer and the video camera can communicate. The computer can download all of the

scenes from the tape automatically, and with perfect digital clarity. As prices fall, video production is

available to us, at home! 

FireWire 400 has a higher sustained transfer rate than even USB 2.0 - so it's still a popular choice for video

camera and hard drives. USB 2.0 was released about 5 years after FireWire 400 just so you get a better

sense of the progression of these two connectors.

And then there's a faster FireWire (800Mbps)

Yes, even FireWire has been improved upon. You can get computers now that have FireWire 800 ports,

which are twice as fast at transferring data than the original FireWire 400 ports. And, you can still connect

up to 63 devices at once should you ever need to do such a thing. FireWire 800 is great when you're

transferring digital audio and video to computer. It is backwards compatible - so you can plug a FireWire

400 device into a FireWire 800 port and it will work.

Mixing and Matching

Well, in a perfect world, all these different kinds of connectors would "just work" together. In my

experience, this isn't always the case. (I'm sure there are other reasons, but here's a common one I've run

into).

So if you have a "bus powered" FireWire hard drive it uses FireWire to power itself in addition to allowing



data transfer. This is great if you're using a computer with FireWire, but if you try to attach it to a Sony

Vaio that uses iLink (smaller 4 pin connector), iLink does NOT provide power. So your hard drive won't

power up, and therefore won't work. The same is true with USB 2.0 "bus powered" devices.

A word about SATA and eSATA

There are lots of "other" kinds of connectors used inside your computer. I primarily have focused on the

"external" kinds of connectors because they are the one's that you see and use on a regular basis. But, I

thought this worth mentioning as it's becoming more standard, and more sought-after. 

SATA stands for Serial Advanced Technology Attachment, and is a way to connect to hard drives inside

your computer. It's fast and can handle a high throughput of data. But, because it's such a great connector

for hard drives, there has been a move to make eSATA drives, "external" SATA.

eSATA transfers at a maximum of 3000 Mbps, and so is significantly faster than either FireWire 800 or

USB 2. Use it if you've got it!

Optical Storage Devices - What's Optical?

There's a whole set of devices known as optical drives. These drives can be divided in two major

categories, CD and DVD drives. Additionally there are readers - those drive than can only access data

already on a disc. Writers or burners can both read data on the disc, and also write data to them.

The data, of course, is stored as binary data that gets written to the disc as millions of tiny bumps and flat

areas, arranged around the circumference of the CD. The disc gets written from the inside of the disk in a

spiral to the outer edge of the disc.

These drives are called optical devices because they use lasers to burn data into the media, or read the data

from the discs. When the laser passes over a flat area in the track, the beam is reflected back to an optical

sensor on the laser head assembly. This is read as a digital 1. When the laser beam passes over a bump, it is

interpreted as a digital 0. If you're familiar with how records (LPs) work with a turntable - optical discs

work in a similar fashion, except they're digital. The smallest entity in the CD format is called a frame, and

holds 24 bytes. Data in a CD-ROM is organized in frames and sectors. A CD-ROM sector contains 98

frames, and holds 2352 bytes.

Because you'd want every CD or DVD, no matter what content it contained, to be playable by any

computer or CD-player or DVD-player, there needed to be a standard. The standard for music CDs is called

ISO 9660. This standard evolved as needs grew, and it is still the basis of music and data CDs.

CD-ROM

For many years computers have come with CD drives. These drives can play your audio Compact Discs,

and can get computer data from a CD-ROM (compact disc, read-only memory). CD-ROMs made the



floppy disk obsolete. They are cheaper to produce than floppies, hold more data than floppies (at least

650MB), last nearly forever, and practically every computer has a drive that can read them. And, the drives

let you play your favorite CD music while you work on your computer. When the CD drive became a

standard in all computers, we saw the beginning of the multimedia computer. We even saw the idea that the

average person could use a computer to do more than just crunch numbers. Just think, you could have fun

with your computer!

Many "ultra-light" portable computers don't have a built-in optical drives. This won't be the immediate

future for standard laptop computers, but for those who are looking for really portable computers, they just

take up space and add weight. You'll still be able to use an external optical drives when you need it.

CD-R/CD-RW

There are CD-R (compact disc, recordable) and CD-RW (compact disc, re-writable). CD-R is the

"standard" that allows you to write data to a disc only once. You "burn" the data or music to the disc. If

your data doesn't take up the entire disc (650MB), then you waste that extra space. You can't write to it

again later. Lucky for us, the disc media itself is incredibly cheap, so there's little financial burden.

With CD-RW, you "burn" data to a thin layer on the disc. But with a CD-RW disc, the layer can be

changed. So you add to your session later, or you can erase the CD-RW to re-use it. The discs are slightly

more expensive than CD-Rs, and in general they tend to be less reliable than CD-Rs. 

DVD

Technically speaking, DVD stands for Digital Video Disc. Sometimes it stands for digital versatile disc.

Mostly, we all know that you can go get your favorite movies on DVD, and watch on your TV or computer.

DVDs can hold over 2 hour of high-quality video, allow for multiple audio and video tracks, have subtitle

capabilities, and can have menus and other simple interactive features. The DVD has made videotape

obsolete, just as audio CD made cassette tapes and albums a thing of the past. 

DVD-R, DVD+R, DVD-RW, DVD-RAM, DVD+RW

Okay, it's crazy out there! If you want to write data to a DVD disc, whether your making your own movie

DVD with menus, subtitles and everything else, or you just want to have 4.7GB (yep, gigabytes) of storage

space to write your files to, this field is a "work in progress".

I have never used, nor do I know anyone who has used the RW flavors of DVD re-writable discs. I'm not

saying those people don't exist, I just don't know anything about it. Let's focus on the more common types,

DVD-R and DVD+R.

DVD-R comes in two flavor (G) and (A). Confused yet? This is what they mean by the "bleeding edge" of

technology. The (A) stands for "authoring" version and (G) is for "general" version. The general version is

intended for home use and writes with a cheaper laser. DVD-R(A) is intended for professional development



and uses a more expensive laser. DVD-R(A) discs are not writable in DVD-R(G) recorders, and vice-versa,

but both kinds of discs are readable in most DVD players and drives. FYI- Apple uses a DVD-R(G) in their

SuperDrives and you can use iDVD or DVD Studio Pro to make your own DVDs on a Mac. The DVD-R

format is the "recognized standard".

DVD+R is another type of format that DVDs can be written to. Philips, Sony, Hewlett-Packard, Dell,

Ricoh, Yamaha, and others support this format. It is not supported by the DVD Forum (the standards-based

authority on how DVD technology should be invented/developed). It's important to know that there is no

real "standard" at this point. It's a little bit of a wait and see game to see which format becomes dominant,

and thereby the standard. In the meantime, if you want to make a DVD yourself, pick either DVD-R or

DVD+R and go for it. Ask your friends, ask people who have made DVDs for their opinions.

Combination Drives

If you buy a new computer, chances are it will have some kind of combination of CD player/CD burner and

DVD player/DVD burner. You can get drives that let you play and burn CDs, and watch and burn DVDs.

In general, the more your optical drive can do, the more expensive it will be, but it will also be able to do

all the functions "below" it...so DVD burners can certainly play DVDs.

What's important to know is that optical drives are running the show in terms of removable storage media.

With blank CDs costing pennies, you may find that burning a CD is the easiest and most effective way to

get files from one place to another.

Blu-ray

Okay, so here's a note about the Blu-ray Disc format. Blu-ray disc, developed by Sony, are a high-density

optical disk that can hold 25GBs (single layer) or 50GB (dual layer) of digital data. It's becoming the

"standard" format that allows us to watch HD (high definition) video on disc. Because HD video takes up a

lot of storage space, a regular 4.7GB DVD won't let you store many minutes of a movie! You can easily

store a 2-hour HD movie on a single layer Blu-ray disc.

Blu-ray technology allows you to archive large amounts of data, audio asset libraries, raw video shoots or

complete multimedia projects on long lasting BD (Blu-ray Disc) media - at a low cost per GB. You can

store up to 50GB of digital data on 1 Blu-ray disc (that's about 10 DVDs worth of data!)

The biggest issue - not many people have Blu-ray DVD players that you need to read blu-ray discs. They

may start coming standard on computers, and the price of stand-alone player (set-top boxes) will surely

come down as adoption rises. At least at this moment, it seems like Blu-ray has "won" the format battle

against the HD-DVD form. Again, stay tuned. 

External Storage Devices

Below you'll find some common options people use to either expand the storage capacity of their computer,

or to transfer files from one place to another. My opinion - larger, faster, cheaper storage is usually your

best bet. Especially if you think you'll need to transfer graphics, audio or video files. You'll quickly learn

that a CD just doesn't have the storage capacity for most files you'll create. 

FireWire or USB 2.0 Hard Drives



You might want to get an external FireWire (or IEEE 1394) or USB 2.0 hard drive. These drives are great

for transferring large amounts of data. They are fast, and per megabyte, offer the cheapest storage you can

buy. The drives come in a lot of different sizes, and the maximum capacity increases by about 40% a year!

Go for as much as you can afford. Terabyte drives are now available in the consumer space!

There are two sorts of FireWire drives -- one is a big box that houses a standard size hard drive. They

typically come with fans to cool the hard drive, and require that you plug them into the wall for power.

These can be great for long-term storage of your files, like for backups. They work fine as a "transfer

medium" but remember, you'll have to lug around a hard drive, power cable, and a FireWire cable. This

may only amount to a few pounds, but when it's stuck in your computer bag, it can really mount up.

Another kind of FireWire or USB 2.0 hard drive is designed with a sleeker profile. These drives are more

expensive than the standard size drives, but they are tiny! (In the computer world, less weight usually

amounts to higher price.) They can weigh literally ounces and can be powered right through the cable. Yep,

they don't have to be plugged in to a wall to work. Just plug the drive right into your computer, and the

computer powers the drive. These are really great, but they can be expensive. 

Most modern computers have FireWire and/or USB ports. So you're pretty safe taking one of these drives

anywhere, and being able to access the data you have stored on it. If I know I'm going to have to transfer

files to PC, I often choose to take a USB drive, because USB is on more PCs than FireWire.

And speaking of USB drives, I've been using my iPod as a hard drive. These are great because they let me

carry around one device. It can hold gigabyts of information, and can also play my music!

USB Flash Drives (Jump drives)

Another popular option for removable storage is called a USB Flash drive. You can get really inexpensive

flash drives that can store gigabytes of data. And they are the tiny! They are great for taking large files with

you. One of the best features of these drives is that they don't require drivers - because they are USB, they

simply work. So you can take files from your Mac and transfer them to someone's PC, or the other way

around pretty seamlessly...and without carting around a huge drive, cables, and a power supply. 

Web Space



Many ISP's (Internet Service Providers) who provide you an email account, also let you have some space to

store digital files. Many people use this space for a web site, but you could also use it to upload and store

your files. When you need the files on the go, you can simply log in to your web space and download the

files.

This has some good uses. A lot of providers let you set up public space where you can put files in a public

drop box where anyone can access them. So, if you have a paper you want to let 20 people all over the

world read, you could leave it on your web space and they could all download it directly. (Or, you could try

Google Docs if you want!)

On the downside, per megabyte, some web space can be really expensive, and a lot of places make you pay

again and again every month for this space. The other problem with web storage is that you have to actually

upload and download your files. This can be time consuming if you are using a slow modem connection,

and sending large files. That and needing to have an Internet connection!

Utility Software

My best advice for performing "housekeeping" chores on your Windows PC is to get yourself a copy of

Norton 360 by Symantec. There are other software makers who make some of the same kinds of utilities,

but Norton has a name we've come to trust. Included with your Windows install is Disk Management.

On the Mac, you can often solve problems by running Disk Utility (comes with your Mac OS X install). It

can verify a disk's integrity and repair the disk if it's damaged. It's especially good for repairing

permissions, formatting and partitioning disks.

Here are some of the tasks you might want to do on your computer to keep it in great working order.

Partition Your Hard Drive

With just a piece of software, you can essentially split your hard drive into two or more parts (these are



often referred to as partitions). You could have your one hard drive divided into a partition that holds your

operating system, and another partition that holds all your applications and documents. Partitions can help

protect your data if your system crashes. They can simplify backups because all your data will be in one

partition, rather than scattered throughout all the other files on your hard drive. You can also install and run

multiple operating systems on the same computer if you install them on different partitions.

Defragment Your Hard Drive

Imagine that your hard drive is nothing more than hundreds of thousands of little boxes that all store data.

Whenever you add anything, a program, a note, audio, video, anything at all, your operating system splits

the data up and begins to fill the small storage "boxes". When you delete a file, the box is emptied, leaving

an empty space within your hard drive.

As your computer loads applications and data, it has to fill the boxes as it sees them, skipping over any

taken boxes. This spreads out the data all over your system – data that should be close together. You don't

actually see any of this happening, you only see the effects of it. A fragmented system can become groggy,

where it takes longer to process information. Defragmenting your hard drive will bump all empty boxes

together (see graphic above) so they are contiguous - or right next to each other. You'll experience better

overall computer performance if data is accessed contiguously, rather than having to jump all over your

hard drive to find the complete document.

Now, as drive capacity increases, the file system doesn't need every single little "nook and cranny"

available, so you may never really need to defragment your hard drive. And, depending on how your drive

was formatted, it may be doing this kind of "shuffling" of files in the background.



On a Windows PC you can use the Disk Defragmenter that is included with your Windows installation (this

is called Windows Defrag under Vista). Just open My Computer. Right-click the local disk volume that you

want to defragment, and then click Properties. From the Tools tab, click Defragment Now.

On a Mac running Mac OS X, there's the OS automatically optimizes the allocation so you don't need to

defragment.

Scan for Viruses

Computer viruses span the range from absolute truth to complete hoaxes. A computer virus is a type of

computer program that is designed to hide in the background of your system. A virus can replicate itself

from one computer to another by attaching itself to existing programs or parts of the operating system. You

can unknowingly transmit a virus from one system to another by copying infected program files from one

machine to another, or by using an infected program downloaded from the Internet. Computer viruses often

infect many programs on the same system, or even parts of the operating system itself in an attempt to

spread themselves as far as possible.

A computer virus will often have a "trigger" such as a specific date, or a specific program being run that

will perform a trivial event (such as flashing a message on the users screen). Some viruses will perform

more malicious deeds however, deleting or scrambling users' files, or their entire system. Some viruses

slow down a system, disable certain functions, or cause erratic system behavior. 

What can you do? Well, firstly, you can regularly backup your data. It's really the best way to know that

your files are safe. If you use a Virus Scanning program, you can regularly check your system for viruses

(McAfee is a trusted antivirus software). You can also password protect your system, this will prevent

anyone else from downloading software to your computer that might be infected.

And the good news if you're on a Mac, to date there have been far fewer viruses that have affected

Macintosh computers than PCs. It doesn't mean you're totally safe on a Mac, just a bit safer.

Anti-Spyware

Spyware is a type of computer virus that collects personal information without your consent. Personal

information is secretly recorded with a variety of techniques, including your logging keystrokes, recording

your Internet web browsing history, and scanning documents on your computer's hard disk. Behavior is

much like those listed above, and often it can completely bring down your entire system. Again, this is a

much bigger issue for PCs. There's lots of anti-spyware software that is designed to clear out already



existing problems, and help prevent future incidents.

Backup Software

If you back up your data on a regular basis, you'll prevent yourself from having catastrophic data loss.

Imagine losing all the papers you've written for school, or last night's excellent jam session with your band.

Sometimes you just can't re-create this kind of data. And, most of us don't think about doing a backup until

it's too late - and our computer has just died.

There are a lot of reasons you could lose data from your computer. Hardware or system malfunction (this

just happen to me, hard drive totally died). Sometimes data is lost due to human error (you accidentally

delete the wrong file), computer viruses, or even natural disasters (hard drive burned in a fire).

Of course, if you were to try to back up your entire computer, all the applications you have, and all the

files, it would take way too long to perform on a daily, weekly, or even monthly basis. But, if you do this

complete back up only once, you can do "incremental" backups, storing only the data that has changed

since the previous backup. So any new documents you create, any new applications you install, each time

you perform an incremental backup the software will look to see what's changed on your system since the

previous backup.

If you're using a Mac, you might consider using the built-in (Mac OS 10.5 and higher) Time Machine

application. It let's you create periodic backups so easily that you'll actually do it. You can set it up to

wirelessly connect to an external drive and then forget it (until you need the backup, and everything is

there.)

On a Windows machine, you can use the Backup utility and back up any folder (or user account) on your

system. You can set a schedule for routine backups and know that your files are safe.

Compressing Files

Compressing your files is a little like voodoo. It magically makes your data files smaller than they really

are. Compression lets you reduce the overall number of bits and bytes in a file, so it can be transmitted

faster over Internet connections, or take up less space on a disk. Typically, when you download

applications from the web they arrived as compressed files. 

Once you download the file, your computer uses a program such as WinZip or Stuffit to expand the file

back to its original size. When you expand the file, it is identical to the original file before it was



compressed - there is no loss of data.

At first glance, this seems very mysterious. How can you reduce the number of bits and bytes, and then add

those exact bits and bytes back later? Most types of computer files are fairly redundant -- they have the

same information listed over and over again. File-compression programs simply get rid of the redundancy.

Instead of listing a piece of information over and over again, a file-compression program lists that

information once, and then refers back to it whenever it appears in the original file.

For example, let's take the fictional example of compressing a word processing document - and let's use this

sentence:
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A compression algorithm could say that the above sentence contains
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etc 

Every time a compression algorithm finds cases where the data is not unique (or finds the letter 'a' used

multiple times, for instance), it would store the letter only once, and then keep a small reference file stating

where it found the letter each time it occurred. Believe it or not, this ends up being less data!

The most common compressed files are those with extensions such as .zip, .sit, and .tar. These extensions

represent popular compression formats for the PC, Macintosh, and UNIX. The compressed file may be a

single file, or a folder that contains multiple files, bundled together into a single archive. An archive file

can sometimes contain video or graphics files within it, and often contains software programs with related

documentation.



Choosing a System that Works for You

When you go into a computer store, you need to understand what the technical specifications really mean.

Many stores are trying to sell you a system, it could be more than you need, or it might not actually meet

your needs. Only you can know exactly what you need out of your computer. The information that we

covered so far should be a good guide to help you understand the basic parts of a computer. This course is

designed as an overview. It should get you asking the right questions, more than necessarily knowing all

the answers. And since technology is changing constantly, you can't possibly know all you need to know.

But, you can know the right questions to ask, and how to ask them, and how to relate them to the

fundamental knowledge you have.

If you're buying a new computer, it's like a jigsaw puzzle. You'll need to put all the pieces together to see

the final picture. Look at the types of things you use a computer for today, and think a bit about what you

intend to use it for in the near future.

Do you need portability? Remember that laptops are more expensive than desktops, but let you do your

work on the go, and give you less need to transfer files from one place to another. You just take your

system with you wherever you go. In the future, maybe you'll want to edit video in the field? Maybe you'll

need to show your multimedia projects to clients? What are your needs?

If you decide you want a desktop system, what size monitor do you need? How fast does the computer need

to be? How much RAM will you need? How large of a hard drive? Will you want to burn your own CDs or

DVDs? Will you be able to "grow" your system as your needs increase?

Internet Service Providers

Often abbreviated ISP, an Internet Service Provider is a company that provides you with access to the

Internet. Typically, you pay them a monthly fee, and they give you a username and password you can use

to access the Internet through their pipeline. They often give you at least one email account, access to the

web, and also some web space that you can use to host a website, blog, or podcast.

Internet service providers are the folks who physically hook up individual customers to the Internet. You

can't connect directly to the Internet, but rather must go through your ISP. They buy Internet access from an

"upstream provider" - or some other large provider. It's almost like a big pyramid. Eventually, the signal

gets passed to one or more "backbone providers", which have the capability to route network traffic across

the country or around the world.

Depending on what your connection is, your ISP could be your phone company, could be your cable

company, or could be someone else who provides Internet access. You'll often get an email address (or a



few) and some web space for file sharing or a website.

The list gives you access to all the Internet Service Providers in the U.S.

http://thelist.com/

Connecting Your Computer to the Internet

As the web becomes bigger and more popular, and web sites get more complex with audio, video and

graphics included on many sites, you'll want to make sure your computer connects to the Internet as quickly

as you need. Maybe you're a casual website browser, or maybe you're trying to upload large video files to a

client - each will have different connection requirements.

There are two basics types of connections: dial-up phone modems and high-speed broadband modems.

There are a few different kinds of broadband connections. We'll look at a few.

Dial-up 
Even with today's complex web pages and large file transfers, many people connect to the Internet with a

phone line and a 56K modem. A modem (which is short for modulator/demodulator) is a device that lets a

computer send digital signals over an ordinary wire phone lines.

Listen to a dial-up modem

The sounds that you hear are analog audio waveforms that the modem converts into a series of binary

digits. If telephone lines were all digital then you wouldn't need a modem to convert from analog signals to

digital pulses. But, a modem lets your computer connect to, and communicate with, the rest of the world.

When you use a modem, you normally use an email program or web browser, or some specific application

to dial the modem on a telephone line. This is called "dial-up connection".

There are a couple of basic types of modems for a computer: external USB modems and internal modems.

The external USB type you set on your desk outside the computer, while the internal modem is not visible

since it's inside the machine. The internal modem is a card that is inserted inside the computer motherboard.

They are included with many computers now.

In general, modem technology is getting quite dated. It's often too slow to be practical for multimedia. And,

if you spend a lot of time on your computer with your modem, then you'll probably end up needing a

second phone line installed in your house so you can still talk to people on the phone. This can get

expensive - or at least comparable in price to either DSL or Cable modems. 

If your ISP only provides dial-up access, then they will give you a local telephone number to "dial in" to

connect to the Internet. When you're online, you can't use your phone, and callers will receive a busy signal

for the entire time you are surfing the web. Only one computer at a time can be connected through a dial-up

account.


